MIP Ad‐Hoc Reporting System – MARS
To access the MIP Ad Hoc Reporting System (MARS), a user must be a registered MIP user and logged
into the MIP. Once logged in, a user will see the MARS Tab. A user can then click on the Access MARS
button from the MARS landing page. Within the system, a user can report on plan information in real
time, run pre‐built reports, create custom reports, and export reports to a worksheet or PDF. When
using the system always continue past security warnings and do not block any Java components from
running.
MARS Reporting System Capabilities:




View canned reports
Create ad hoc reports
Data is one day old

Key Terms:







Business Objects ‐ The MARS Reporting System software
Web Intelligence Document ‐ Query template
Query ‐ Included data elements and filters needed to create/modify a report
Report ‐ the result of a query
Ad hoc Reports ‐ These are custom reports that can create
Canned Reports ‐ These are pre‐built reports

Key Features:




Can have multiple reports open at the same time and toggle back and forth between them
Expanded Actions ribbon that allows user to complete steps faster
Advanced graph layout options
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Home Page
Upon Opening the MARS Reporting System users will see the “Home” page. This page will serve as a
dashboard which allows users to quickly see Recent Viewed Documents, Inbox Messages, Recently Run
Documents, and any Unread Alerts.
Tip:


A User can always toggle back to the “Home” page by selecting Home tab on the Tool Bar

Home Page Screen
Next to the Home tab is the Documents tab.

The Document tab takes users to the Reporting System Home Page (Shown Below). This page is where
users can run and edit reports. In addition, from this page users can view the Navigation panel where
they can locate My Documents, Folders, and a Search function.
Tips:



Please note the page is defaulted to load with the Navigation panel opened to Folders (As
Seen Below)
To locate My Favorites: Click on the My Documents Tab within the Navigation panel. Doing
so will display the My Favorites folder (Image 2)
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Documents Main Page

Navigation Panel to My Documents Panel
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Canned Reports
Canned Reports are pre‐built reports that users can run in the reporting system. Complete the following
steps to run a canned report:
Steps:
1. Access the Folders List through the Navigation panel
2. On the left‐hand navigation, click the plus sign (+) next to the Public Folders to
expand the folder
3. Click on MARS System Published Reports
4. Open the report to run by double clicking on the canned report

MARS Canned Report Menu

NOTE:




Users may need to fill out a prompt that appears. For example, in the Plans in
Region canned report, users will need to enter the State and Plan Type parameters
to query. Select values on the Prompt screen by double clicking on the value or by
clicking once on the value and pressing the “>” button in the middle of the screen.
Remove selected values by clicking the “<” button. After completing the required
prompts, the Run Query button on the bottom right of the Prompt screen will
activate
Press the Run Query button to run the report
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Tips:
 On the bottom, right‐hand corner of the screen, users can navigate the report by
pressing the arrows to move forward or backwards one page at a time. Jump to
pages by using the Report Navigation menu. When users run a report, only the first
page will display and the Report Navigation menu will only show 1 of 1 pages even if
there is more than 1 page. To view the total number of pages, click on the Jump
Forward button to skip to the last page (Image 1)
 To change the original prompted values, press the Refresh Data button (Image 2)

Arrow Buttons
Navigation
Menu

Report Navigation Menu (Image 1)

Actions Ribbon (Image 2)
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Refresh Button

Saving a Report
Users can save reports to local computers or to the Favorites Folder. To see the saving options, click on
the Disk which is located on Actions Ribbon.

Save Button

Actions Ribbon

Steps to Save to a Local Computer:
1. Click on Save To My Computer As
2. Click on Excel to save the report into an Excel spreadsheet or PDF to save the report
into a PDF document or on your computer
NOTE:






Depending on local computer security settings, a pop up blocker may appear when
trying to download a file. To avoid a pop up blocker appearing on the screen, hold
down the Ctrl key when clicking on the drop‐down menu. Continue to hold down
the Ctrl key until the Save As screen
When exporting a report to Excel, by default the upper left of the table will not be
located at cell A1. To ensure the table is at the top left corner take the following
steps:
1. Right‐click on the four small arrows on the top left corner of the table in the
report
2. On the menu select Align and then Relative Position
3. On the menu that pops‐up, go to the Layout tab, set the left and top
positions of the table to 0 inches, and click Apply and then OK
In the saved Excel, before doing any action on the cell, change the Format Cells of
the cell from “General” to “Text.”

Steps to Save to My Favorites:
1. Users must save canned reports to My Favorites before being able to edit them.
When saving, confirm the file names and titles of the copied canned reports have
been changed to distinguish them from the original reports. Reports under My
Favorites can be scheduled to run automatically which can then be emailed. To save
a canned report to My Favorites while a report is open, click on the Document drop
down arrow and click on Save As
2. Save created ad hoc reports to My Favorites as well. The workflow for saving ad hoc
reports is identical to saving copies of canned reports
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Steps to Save to Working Folder:
1. A group folder has been set up for anyone to save and/or edit ad hoc reports. The
Working Folder can be accessed by clicking on the Public Folders and then MARS
System Published Reports
2. This is a more efficient way of sharing reports with multiple people
3. When saving a new report to the folder, make sure to give it a clear title
4. When saving in the Working Folder, do not override someone else’s report
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Scheduling a Report
Configure the MARS Reporting System to schedule recurring reports:
Steps:
1. Select the report to schedule by right clicking on it
2. Right‐click on report to bring up menu and select Schedule (Image 1 below)
3. Click the Schedule button, once the other options have been completed on the
bottom right corner to schedule to the report (Others options steps outlined below)
4. To view the status of a scheduled report, find the report in Document List, right‐click
on the report, and select History. Users can also delete, pause, and edit scheduled
instances from the History menu (Image 2 below)

Schedule Button

Schedule Menu (Image 1)
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History Button

History Menu (Image 2)

Other Options within the Schedule Menu
Recurrence Schedule:
1. Click on Recurrence in the left‐hand navigation panel. Select the Run object drop
down box, choose the report run frequency and enter associated details to schedule
when the report will run (which day of the week and which time). The start and end
dates/times only specify during which time periods the reports can run
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Recurrence Menu
Selecting Formats and Destinations:
1. Click on the Formats or the Destinations in the left‐hand navigation bar within the
Schedule widow to choose the format options
2. Under Output Format table, check the box next to the format and destination for
the report
Note:




Do not select Web Intelligence if emailing the recipient. The recipient will receive
the link in his or her email, but the tool is not set up to work off email. Only select
Web Intelligence if selecting Inbox in the Destination drop down box
Always choose Inbox or Email recipients. When emailing a recipient, choose either
Microsoft Excel or Adobe Acrobat. Be advised there is a difference between Inbox
and Email recipients
 Inbox ‐ This is not the user's email inbox, but the user's Reporting System
inbox. Use this option to send reports to other users. Sending to the inbox
as a Web Intelligence document allows the user to modify the data
elements and filters
 Email recipients ‐ This option can be used for sending reports to other users.
The report will appear as an Excel or PDF attachment in the user's email
account of their choice
 Complete the email fields to send the report to a user. Any standard email
address will work
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Check the Specific name radio button to add a name of the report to display
in the email attachment. If Automatically Generated is selected, then the
report name will be a random set of numbers and letters that appears in the
user's attachment 10. Keep the Add file extension box checked. This will
automatically add the correct extension

Tip:


If the report requires a user to enter values in a Prompt screen, click on Prompts in the left‐hand
navigation bar. Then click the Modify button to pop up the Prompt screen, where the user can
enter the prompt information

Formats and Destinations
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Creating a New/Ad Hoc Report
What is an ad hoc report? By creating an ad hoc report, users can generate data on the fly for any plan
in the MARS system and manipulate the data to create a custom report.
Things to think about prior to creating an Ad Hob Report:
1. First pick what plan information will be displayed in the report
2. Decide how the report will query plan information by creating a filter
3. Run the query, which pulls the plans that meet the criteria set in the filter and
displays the information specified
4. Edit the resulting report to meet further needs
5. Save the report, so it can be run on demand
Note:


Ad hoc reports and Java: Users may run into issues with Java compatibility when creating ad hoc
reports. Please ensure that the 32‐bit version of Java installed on the computer.

Performance Considerations:
When running ad hoc reports, querying too much data at once may cause performance issues. Always
try to apply filters to only query the plans desired. Adding too many objects to the Results Objects pane
may also have a performance impact. If an ad hoc report takes more than 15 seconds to run, take the
following steps:




Add more restrictive filters
Remove objects from the Results Objects pane
Confirming that the Retrieve Duplicate Rows property is unchecked
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Create ad hoc Repots
Steps:
1. To create a new report, click on the Applications Tab located in the top right hand
corner (Image 1)
2. Click on the Web Intelligence Document button (Image 1)
3. Then click on the New Icon located in the Actions ribbon (Image 2)
a. This will display a new window that will prompt a user to select the
Studies, Revisions, or Amendments Universe (Image 3 below)
Note:


A user can only select one universe at a time. Once you select a universe you will
only see data elements related dot that universe.

Application
Button

Application View (Image 1)

New Button

Action Panel (Image 2)
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Web Intelligence
Button

Create a new universe window (Image 3)
Tip






If saving a report to My Favorites make sure to check the Refresh on open box under
Advanced when saving the report
Users can also schedule ad hoc reports to be emailed the same way as saved canned
reports in the My Favorites folder
When creating ad hoc reports, start by creating a simple query. Modify your filters
till you are pulling only the plan records you desire. Once you have finished
configuring the filters, make sure you include all the data elements that you would
like to report on in the Result Objects pane
Finally, format your report to your liking, and share it with your colleagues by saving
it to your computer and emailing it
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Edit/Modify ad hoc Reports
Steps:
1.
2.
3.
4.

5.

6.

7.

8.
9.

10.
11.

Find the existing ad hoc report, right click on it and press the Modify Menu Option
Click on either the Studies, Revisions, or Amendments Universe
Pass through any warnings or pop‐ups that appear. Don’t block or restrict anything
Once on the page showing the available data, navigate through the data elements
on the left‐hand side under the Universe Objects pane. Click on the + to open
folders containing data elements
Move the desired data elements into the Result Objects pane to be included in the
report. They will automatically populate a table of the report, after running the
query. Users can select and drag elements or double‐click on them to move them to
the Results Objects pane
To filter the query, drag and drop the data element(s) to the Query Filters pane
below the Results Objects pane. The data elements that are placed in the Query
Filters pane are used to define which plans will be reported on once the query is
run. For each data element added to the Query Filters pane, users must specify the
conditions that must be met for plans to be included in the report
Once a data element is added to a Query Filter, users should configure the filter
settings for the element
a) Condition – The system compares the records to the Value using the
Condition. The available conditions include Equal To, Not Equal To,
Greater Than, Greater Than Or Equal To, Less Than, Less Than Or Equal
To, Between, Not Between, In List, Not In List, Is Null, Is Not Null,
Matches Pattern, Different From Pattern, Both, and Except
b) Value‐ Users can enter free text in the Value field when the Value
Options menu is set to Constant
c) Value Options‐ The options in this menu define how the input
parameters are selected for the report
d) Value for the Query:
a. Constant – Free text entry of the Value
b. Value(s) from List – Pull Values from a list of available
Constant
c. Prompt – Have a Prompt window pop‐up whenever the
report requires a value input
d. Result from Another Query – No used
Once the data elements and filters are set, click the Run Query button to view the
report results
After querying the data, the resulting report will be displayed. The data elements
chosen will be structured in the same order that was placed in the Results Objects
pane. Users can edit the report’s formatting and structure
To refresh the data, press the Refresh Data button
To make changes to the query or add new data elements to display, click on the
Edit Query button
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12. Save the new report by clicking arrow next to the Save button on top left corner of
the screen
Tip


Notice that when dropping data element marked with a green pyramid, it will
always bring over the parent data element. The following Object Types are
available:
 Dimension Object (blue box) – base elements for creating a query
 Detail Object (green pyramid) – provides additional information for a
dimension object, but does not form the basis of a query
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